Graphing on Excel

Directions:. 
1. Contact me at mbauman@mckasd.net and request an electronic copy of this assignment. The email subject should be AP Summer Graphing Assignment. Please include your name in the body of the email.

2. Save this file as a WORD document 

2. Use Excel—any version you have to graph data… (or another spreadsheet style application) 

3. Copy and paste the graphs AFTER each data set.

4. Answer the questions AFTER each graph.

5. Save Frequently!

6. Bring Hard Copy on the 1st day of class 
Example of a graph well done based on the following data:
	Time (hr)
	Average Length of Root Tips in Solution with Al Ions (mm)
	Average Length of Root Tips in Solution without Al Ions (mm)

	0
	2.0
	2.0
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USING EXCEL TIPS

There are many ways to make graphs using Excel.  Here are a few pointers that you can use for both the newer Excel and the older versions which are on many computers.  It is important that your graphs are accurately presented in your lab reports.  You want to have both a written description and graphical description of your results.  Your graph should be able to tell the story of your results on its own…

USING OLDER EXCEL (up to 2003)

Making a Graph

1. Compose your data in a formatted table in Excel.

2. Insert ( Chart (or use the Chart Wizard Icon)

3. For continuous data, you need to use line graphs, choose the XY (Scatter) type. Bar graphs follow similar but not identical procedures listed below.

4. Click on the “Series” tab. 

5. Click “Add”.

6. In the “Name:” box, put the correct label for this line/series. 

7. In the “X Values:” box, click the right most section and then choose the cells that you want for the X-axis.

8. In the “Y Values:” box, click the right most section and then choose the cells that you want for the Y-axis.

9. Repeat steps 5 ( 8 for each line/series you want to include. (You should see the points being plotted in the preview pane of the Chart Wizard—without a line)

10. Click “Next>”.

11. Under the tab “Titles”, put the title for the graph as well as the headings for each axis.

12. Under the tab “Axes”, make sure both values boxes are checked.

13. Under the tabs Gridlines”, “Legend”, “and “Data Labels”, decide which looks best.

14. Click “Next>”.

15. Choose where you want to place the graph.

Formatting a Graph 
16. Now that you have your graph, you can make it look presentable for your data.

17. Right-clicking on the title, axis labels, or legend gives you formatting options for all.

18. Right-clicking on the axis numbers (or anywhere on the axis) lets you format the appearance (font, color, how many decimals) of the numbers as well as scale shown (min/max values, major/minor divisions, linear or logarithmic, for each axis.  You have to do this for both axes!

19. Right clicking on any of the points of one line and clicking on “Format Data Series” lets you modify the color/shape of the points, whether or not to connect the points, etc. (remember, if you have more than one line, you might need to adjust these more than once).

Using a Best-Fit line (Regression Analysis/Trendline)
20. Right clicking on any of the points of a line and clicking “Add Trendline” gives you the best fitting curve for the points.  This is done mathematically for you based on the data—not just drawing a line through the points by eyeballing the data. 

21.  Under the “Type” tab, choose linear or logarithmic (for the respective series you want this for).  Under the “Options” tab, you can forecast the best fit line forward or backward (units are based on axis scale) for extrapolation purposes.  You can also click on the boxes for “Display equation on chart” (for determining slope as well as the exact values of interpolated points using y=mx+b) and “Display R-squared value on chart” (for seeing how well the variables correlate with each other—closer to 1.0 shows a high degree of correlation; the ‘goodness of fit’ is very high; observed values very close to expected).

22. Right-clicking on the trendline itself lets you change the label shown in the key, the color and or width of the line, etc.

USING Recent versions of EXCEL 
Making a Graph

1. Compose your data in a formatted table in Excel.

2. Under the Insert tab, select “Scatter” from the list of charts.  Choose the one that is just points (markers).  Bar graphs follow similar but not identical procedures listed below.

3. A new set of tabs open up.  It should be highlighted at the top of the Excel window.  You can get these tabs anytime you click on the graph itself.  Under the tab Chart Tools ( Design, chose “Select Data”.

4. Click “Add”, under the Legend Entries (Series) menu.

5. In the “Series name:” box, put the correct label for this line/series. 

6. In the “Series X Values:” box, click the right most section and then choose the cells that you want for the X-axis.

7. In the “Series Y Values:” box, click the right most section and then choose the cells that you want for the Y-axis.

8. Repeat steps 5 ( 8 for each line/series you want to include (you should see the points being plotted in the preview pane of the Chart Wizard—with a line). Select “Ok” when you are done.

9. You should now see the graph in your Excel window.  To remove the old-fashioned ‘connect the dots’ line, right-click on the actual graphed line.  Select “Change Chart Type” and choose the type that just shows the points.

10. Under the tab Chart Tools ( Layout, choose “Chart Title” and enter the title you want for the graph.

11. Under the tab Chart Tools ( Layout, choose “Axis Titles”, then select either “Primary Horizontal Axis Title” (for the X-axis) or the “Primary Vertical Axis Title” (for the Y-axis) and enter the labels you want for each.

12. You can alter the appearance of where the Legend shows or Data Labels with the drop down menus.

Formatting a Graph 
13. Now that you have your graph, you can make it look presentable for your data.

14. Right-clicking on the title, axis labels, or legend gives you formatting options for all.

15. Right-clicking on the axis numbers, then selecting “Format Axis…” lets you format the appearance (font, color, how many decimals) of the numbers as well as scale shown (min/max values, major/minor divisions, linear or logarithmic, for each axis.  You have to do this for both axes!

16. Right clicking on any of the points of one line and clicking on “Format Data Series…” lets you modify the color/shape of the points, whether or not to connect the points, etc. (remember, if you have more than one line, you might need to adjust these more than once).

Using a Best-Fit line (Regression Analysis/Trendline)
17. Right clicking on any of the points of a line and clicking “Add Trendline” gives you the best fitting curve for the points.  This is done mathematically for you based on the data—not just drawing a line through the points by eyeballing the data. A window called “Trendline Options” will open up for trendline selection and formatting.

18.  Under the “Trendline Options” subcategory, choose linear or logarithmic (for the respective series you want this for).  You can also forecast the best fit line forward or backward (units are based on axis scale) for extrapolation purposes.  You can also click on the boxes at the bottom of the window for “Display equation on chart” (for determining slope as well as the exact values of interpolated points using y=mx+b) and “Display R-squared value on chart” (for seeing how well the variables correlate with each other—closer to 1.0 shows a high degree of correlation; the ‘goodness of fit’ is very high; observed values very close to expected).

19. The other three selections in the “Format Trendline” window (“Line Color”, “Line Style”, and “Shadow”) are for formatting the appearance of the trendline.
1. Baby chickens, like all baby birds, require a constant source of food. As chicks grow, more energy is required for daily activities, and their food requirements increase. The following data table reports the average food eaten by a group of 10 chickens over a 5-day period.  Prepare a graph of the data points along with a best-fit curve (regression analysis trendline).

	Baby Chicken Food Consumption
	Questions

	Day
	Average Food Consumed (g)
	1. Identify the independent and dependent variables.

2. How much grain will the chicks eat on day 6?

3. On day 7?

4. Both questions 2 and 3 have you extrapolating data from the set of points using a trendline.  What is a danger of doing this?



	1
	1.0
	

	2
	3.2
	

	3
	6.5
	

	4
	10.6
	

	5
	15.4
	



PASTE GRAPH HERE
2. Elodea, a water plant commonly found in aquariums, gives off bubbles of oxygen when placed in bright light. Students in a biology class noted that if a light were placed at different distances from the plant in an aquarium, the rate of bubble production varied. The following data table shows the average results from several trials.  Prepare a graph from the data.  Create two trendlines—one linear and one logarithmic.

	Elodea Bubble Production
	Questions

	Distance from Light 

(cm)
	Bubble Production Rate

(bubbles/min)
	1. Identify the independent and dependent variables. 

2. Use the R2 values to decide which trendline best fits the relationship that exists.  Which did you choose and why?

3. Estimate the O2 production at 25 cm.

4. At 40 cm?

5. Questions 2 and 3 have you interpolating the data from the set of points.  Can you do this if using a bar graph?  

	10
	40
	

	20
	20
	

	30
	10
	

	40
	*
	

	50
	3
	

	*They forgot to record data at this distance!
	



PASTE GRAPH HERE
3. The data below summarizes the results of a scientific experiment on the effects of a growth hormone (gibberellic acid) on plant height. A 0.1 molar solution was used in all experiments. Graph the data below—include a trendline for the given data.  

	Gibberellic Acid and Plant Height
	Questions

	 Gibberellic Acid (0.1 M) 
(mL)
	Plant Height at 
1 Week (cm)
	1. Identify the independent and dependent variables. 

2. Explain why the plant height at 50 mL is not consistent with the rest of the data.  What evidence can you use from the regression analysis to make this point?

3. Plot a second series that does not include the plant height at 50 mL of gibberellic acid and make a second trendline.  How does this new analysis differ from the previous one?

	20
	8.5
	

	30
	23.8
	

	40
	45.2
	

	50
	15.7
	

	60
	91.3
	



PASTE GRAPH HERE
4. A team of scientists wanted to test the effects of temperature on the germination rate of pinto beans. They placed three sets of 100 pinto bean seeds in temperature-controlled chambers: Chamber A was set at 15o C, chamber B at 20oC, and chamber C at 25oC. Their results are shown in the table below.  Plot the data including trendlines for each.
	Germination Rates of Pinto Beans
	Questions

	Day 
	% Germination 

(15o C)
	% Germination 

(20o C)
	% Germination 

(25o C)
	1. Identify the independent and dependent variables.

2. Summarize the experimental results.

	0
	0
	0
	0
	3. 

	2
	2
	10
	10
	

	4
	10
	30
	50
	

	6
	20
	40
	80
	

	8
	20
	60
	90
	

	10
	35
	70
	90
	



PASTE GRAPH HERE
5. A number of Colonie High freshmen were working on their Making Connections lab and they collected data from over 100 students regarding their pulse rate at rest.  The results are shown in the table below:

	Resting Pulse Range (beats/min)
	Number of Students
	1. Summarize the significance of the ‘curve’ (pattern) shown by the graph.

2. Why would a line graph be inappropriate for this set of data?



	≤50
	8
	3. 

	51-60
	18
	

	61-70
	41
	

	71-80
	52
	

	81-90
	20
	

	≥90
	11
	



PASTE GRAPH HERE
Data is ‘continuous’; use a line graph








XY (Scatter) graph style chosen for line graphs; used for comparing values of continuous data





Title: clear and accurate





Axis is modified to show correct range—depends on the data (here, it wouldn’t make sense for the X-axis scale to go to 10; you could actually modify the Y-axis just to show from 2.0 to 4.0)





R-squared value is a measure of “best fitness” closer to 1.0, the better fitness of curve; show on graph





R-squared value is a measure of “best fitness” closer to 1.0, better fitness of curve; show on graph





� EMBED Excel.Chart.8 \s ���





Legend defined clearly labeled





Series 2—pink squares are actual points, red line is regression analysis (best fit line)





Both axes need to be labeled accordingly—units included





Series 1—dark blue diamonds are actual points, light blue line is regression analysis (best fit line)





Type answers for Problem Set 1 here:











Type answers for Problem Set 2 here:

















Type answers for Problem Set 3 here:

















Type answers for Problem Set 4 here:

















Use a bar graph for this set of data!  Be careful to format it properly.





Type answers for Problem Set 5 here:
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